What is a Podcast?
Below is a definition of podcasting pulled from Wikipedia that provides you with information about podcasting, its roots and some of the techincal aspects surrounding podcasting.  The following is provided free from editing and I take no credit for this wonderful explanation.

Podcasting, created by former MTV VJ Adam Curry, is a term that was devised as a crisp way to describe the technology used to push audio content from websites down to consumers of that content, who typically listen to it on their iPod (hence the "pod") or other audio player that supports mp3 at their convenience. The term podcasting is meant to rhyme with broadcasting and is a derivative of the iPod platform. While not directly associated with Apples iPod device or iTunes music service, the company did contribute both the desire and the technology for this capability. Podcasting is not unlike time-shifted video software and devices like TiVo, which let you watch what you want when you want by recording and storing video, except that podcasting is used for audio and is currently free of charge. Note, however, that this technology can be used to push any kind of file, including software updates, pictures, and videos.

Podcasting uses an XML-based technology called RSS, or Really Simple Syndication. Content publishers describe new content in an XML RSS file which includes dates, titles, descriptions, and links to MP3 files. This auto-generated file is called an RSS feed. The key to making podcasting work with RSS is enclosures, a feature supported by RSS 2.0.

What makes podcasting special is that it allows individuals to publish (podcast) radioshows, that interested listeners can subscribe to. Before podcasting you could of course record a radio show and put it on your website, but now people can automatically receive new shows, without having to go to a specific site and download it from there.

Related Terms: podcast, podcaster, broadcatching, podcatching
What is it?
First of all, it's still in development, and may not live up to all expectations. But it does work and hundreds thousands hundreds of thousands of people are using it every day.

iPodder is small program that runs on your computer. Its only purpose is to download audio files, usually mp3's, directly to your mp3 device. Currently iPod is supported on both Windows and Mac.

And it's not just for iPods! Other devices are supported through Windows Media Player. Any device that can exchange files with WMP will work with iPodder.

iPodder.org is home to the community that develops iPodder applications and programming to subscribe to.

Get into the exciting world of downloads and podcasts!

As part of a trial we're offering a selection of programmes and highlights packages as downloads and podcasts. This is in addition to the BBC Radio Player where you can already listen to most programmes.
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Three ways to listen - explained

1. Listen Now

Listen now lets you listen to your chosen programme via the BBC's Radio Player.

In order to do this you need to be online. When you click the Listen Now link the Radio Player should appear in a small new window, and the audio should start playing automatically. For this to happen you will need to have Real Player installed.

If you are having problems with Listen Now and the Radio Player then try our Audio Help section.

Audio Help section
2. Download

Downloading lets you save a copy of your chosen programme of package onto your computer. You can then listen to this whenever you want, or even transfer it onto your portable MP3 player.

How you download the audio will depend on the set up and settings of your computer. Usually, if you want to download the audio you need to click on the link using the button on the right hand side of your mouse. You should then see a list of options including either "Save Target As…" or "Save Link As…". If you select this option (or a similar option containing the word "save") you should be able to save the audio file (MP3) to your computer. Remember to save it to a folder you'll be able to find again later. 

If you click on the Download link using the left hand button on your mouse, the audio will usually play. How this happens will depend on the set up and settings of your computer. Usually your default media player will open and the audio will start playing automatically. 

3. Podcast

Podcasting lets you automatically receive the latest episode of your chosen programme as soon as it's available. You need to "subscribe" to receive a podcast, rather like you might subscribe to a magazine and get it delivered each week. An important difference is that all of the BBC's podcasts are free, and you can stop receiving the files at any time.

In order to sign up for a podcast you need an internet connection and a piece of podcast software which is usually available free of charge. This software can check the BBC for new episodes and automatically download them for you.

The steps you go though in order to subscribe to a podcast will vary depending on which software you choose. You can read more about this in our Step by Step guide to getting a podcast.

Step by step guide to getting a podcast
Step by step guide to getting a podcast

There are three steps involved in setting up your personal computer to receive podcasts.

1. Get some podcast software

You need to install a piece of software which will search the web to find the latest episode and automatically deliver it to your computer.

This software is usually free, and these three are popular with BBC users:

· iTunes
· Juice
· Doppler
List of podcast software on podcastingnews.com
(always read the set-up and help guides for new software)
The BBC is not responsible for the content of external websites
2. Subscribe to podcasts

Once you have the software installed you need to subscribe to some podcasts.

How you do this will vary depending on which software you have chosen. Here is a rough guide to how this might work:

If you have iTunes
You can subscribe to some podcasts through the iTunes Podcast Directory. 

If you can't find the podcast that you want in iTunes then you can follow the same method as outlined below for Juice, Doppler and other podcast software.

If you have Juice, Doppler or other podcast software
If you have Juice, Doppler or another piece of software then this is likely to be the method you will need to follow. This is also the case if you can't find the podcast you want in iTunes.

In all of these cases you need to add the "feed" of the podcast to your software. The feed is really just the address of the podcast, which the software will go to each time it wants to check for a new episode.

You can find the feed for any BBC podcast by clicking on either the orange XML button, or the yellow Podcast button. In both cases the feed address will appear in the address bar of your internet browser. It will start with http://downloads.bbc.co.uk/...

You will need to copy this feed address and paste it into your podcast software. How you do this will depend on your software, but you should look out for buttons or links that say "Add" or "Subscribe".

3. Listen to the audio

When a new episode becomes available for the podcast you have subscribed to, your software will automatically download it. You can then listen to this episode on your pc or transfer it to your portable player to listen to later.

You may want to check the settings of your podcast software for details including how often it will check for new episodes, whether it will keep old episodes for you etc. This will vary depending on the software you have chosen, and your personal preferences.

As a general rule BBC programme files will be made available shortly after broadcast. In some cases this may be several hours.

If you decide that you no longer want to receive podcast episodes then it should be very easy to unsubscribe. Again, how you do this will depend on your software, but you should look for "Clear" or "Unsubscribe" options.

Can the BBC offer the Archers as a download and podcast?

Unfortunately the rights situation is very complex for all radio drama, including the Archers. Therefore we can't offer any radio dramas as downloads and podcasts as part of the current trial.

Why are downloads only available for 7 days after broadcast?

Currently most BBC radio programmes are offered online for 7 days after broadcast, via the BBC Radio Player, as this is what we have negotiated with our rights holders. To be consistent with this we are also offering programmes as download and for podcast for 7 days after broadcast.

Why are there only a small number or programmes available?

At the moment we are only offering a limited number of programmes, as part of a trial.

Why are there no comedy programmes offered as downloads and podcasts?

Unfortunately the rights situation is very complex for all radio comedy, including archive comedy from BBC7, and this prevents us from offering any radio comedy as downloads and podcasts as part of the current trial.

Why have you removed the music from some of the downloads and podcasts?

Unfortunately the rights situation is very complex for all programmes featuring music which is available commercially. This prevents us from offering any programmes featuring commercially available music as downloads and podcasts as part of the current trial.

We are able to offer music from unsigned artists, and you will find several of these in the list of available programmes.

Do I need to have an iPod or MP3 player to listen to downloads?

No you don't. Anyone with a computer connected to the internet can download and listen to MP3 files. You will need a media player on your computer (many PCs come with Windows Media Player), and you'll also need speakers or headphones. The advantage of transferring the downloads onto a portable player is that you can then listen to them on the move.

Do I need to have an iPod or MP3 player to subscribe to podcasts?

No you don't. Anyone with a computer connected to the internet can subscribe to and receive podcasts. You will need to install a podcasting application and you can find a list of these here: 

podcast software (The BBC is not responsible for the content of external websites) 

The advantage of transferring the podcast downloads onto a portable player is that you can then listen to them on the move.

I've downloaded an MP3 but I can't hear anything. What could be the problem?

There could be a number of problems, and we're unable to give comprehensive advice. You should check that you have a media player on your computer (e.g Windows Media Player or iTunes). You should also check that the sound is turned up on your machine, and that your speakers or headphones are connected.

I've subscribed to a podcast but I'm getting an error message. What could be the problem?

This may depend on the podcasting application that you are using. You should refer to the Help or Trouble Shooting section in your application. You may also want to delete the feed and re-subscribe. If you are having persistent problems you may want to choose another podcasting application. You can find a list of these here: 

podcast software 

(The BBC is not responsible for the content of external websites)
I’m clicking on the download and it’s playing rather than downloading to my computer. Why is this happening?

The way that you experience MP3 downloads will depend on your setup – e.g. whether you are on a PC or Mac, and which operating system and browser you are using. In many cases clicking with the left button on the download link or icon will play the file. Clicking with the right button on the link or icon should display a list of options. One of these options is likely to be "Save Target As…" or "Save Link As…". If you select this option (or any similar option containing the word "Save") then you should be able to save the MP3 to your computer.

I am on a Mac, how do I download the MP3 files?

If you hold down the Control (ctrl) key on your keyboard whilst clicking on the MP3 link with your mouse a menu of options should appear. One of these options should be "Download Link to Disk" or "Download Linked File". If you select this option this should activate the download and should save it to your desktop.

I can't hear anything - what can I do?
1. Check you have RealPlayer installed on your computer - read more about installing Realplayer

2. If you are using Netscape or Opera, check you have the plug-in downloaded and installed - read more about plug-ins for Netscape and Opera

3. If you are using a Mozilla-based browser, check you have the plug-in installed to the correct place - read more about plug-ins for Mozilla-based browsers

4. Can you see any text in the status window beneath the 'listen live' link? Wait until it says 'Playing'

5. If the text in the status window says 'Playing' but you still can't hear anything, check your speakers are on and the volume is turned up

6. If you do not have JavaScript enabled you will not see any text in the status window until you enable it - read more about enabling JavaScript

7. If you are using a Mac, you will not be able to skip forward 5 or 15 minutes due to technical restrictions outside our control

8. If you are at work, your company may have a 'firewall' enabled to securely protect its internal data. Sometimes your company's 'proxy' settings may be set in such a way that they prevent external streaming sources from occurring. If this is the case, please contact the IT department of your company

9. By default, RealPlayer / RealOne tries to detect the best settings for your connection. Technically, it looks for the best settings for RTSP and PNA transports. 
Below we offer some advice which may not be suitable for your set-up but which has been helpful to some users. For comprehensive advice, please look at the Real help pages http://service.real.com/faq/index.html#playing. 
Before making this change to your Real Player check with your firewall administrator, if applicable, regarding your organisation's policies on Internet access. 
Ia. In Real Player: 
Select view > preferences. Then select 'transport' tab. 
In the transport preferences dialogue select 'use specified transports' then go to point 2 below. 
OR 
Ib. In Real One: 
Select tools > preferences > network transports. Select 'manually configure connection settings'. 
II. In both 'RTSP settings' and 'PNA settings' de-select 'attempt to use Multicast for live content'. 
Additionally you could try setting both transports to use just TCP. This is not recommended for dial-up users but should be okay for ASDL users. 

10. Users of Mac OS X may need to run their browser in Classic mode 

11. It's possible your computer isn't set up properly to handle the file types used in the Player. 
This can be the case if you have recently installed or upgraded Real Player or Real One or other sorts of media players.
Seek professional advice before making any changes to your system. 
The BBC is not responsible for any changes you may decide to make to your computer set-up. 
The following is intended as a guide only to help you diagnose any problem you may be having. 
If you are on a network, check with your network administrator. 
If you use a stand alone computer, read the help provided in your operating system concerning file type associations. 
To do this in Windows 9x, go to Start > Help; click on the Search tab and type in "file type associations", click 'List topics', select the relevant topic and read the advice provided.
A file type used predominantly in the Radio Player is the one which ends with the .rpm extension. This, and also the .ra and .rm file types, may need to be associated or re-associated with the Real Player or Real One application.

12. If all else fails, try reinstalling RealPlayer
I see a blank page - what can I do?
A small number of people have reported seeing only a blank page when they go to the Radio Player. 

If this is happening to you, first of all try refreshing the page by pressing Ctrl+R. 

If this does not work, you can use the the frames-free version to get to all of the BBC's radio stations and genres. 
An error message has appeared - what can I do?
Check that you have RealPlayer installed on your computer - a variety of error messages are associated with not having RealPlayer installed. If the error message appears in a RealPlayer window, please consult the RealPlayer support site (http://service.real.com/realplayer/) 
Why don't you stream your radio stations / on demand programmes using a higher quality bit-rate?
Streaming higher quality audio on the web is expensive and we have to find a balance between audio quality and cost. Since the Radio Player is very popular we are unable to stream music programmes in a higher quality, but we believe we've got the balance right in order to offer the best value for our services. 
Do you have plans to use any other streaming formats?
New digital stations 1Xtra, 6 Music, Asian Network, BBC 7 and Five Live Sports Extra are now available to listen to in Windows Media format. We have no immediate plans to use any other streaming formats 

Why do you only offer some stations in Windows Media Player format?
Because of cost constraints we are currently unable to offer Radio 1,2,3 or 4 in Windows Media format. However, our new digital stations and Radio Five Live are available to listen to with Windows Media Player. 

Why does the stream sometimes stop for a while or stutter?
Audio technology on the internet is still relatively new. The amount of information that can travel along the average telephone line is limited. This can cause a queue in the audio signal. Current streaming technology makes best efforts not to lose this information and holds or 'buffers' it until the line is clear to receive further information. This is why there is sometimes a stuttering or delaying effect when receiving a stream.

Unlike other forms of broadcasting, the cost of streaming has a per capita cost which is not diminished in proportion to the size of the audience. Ironically, due to the growing success of our streaming services, including audio-on-demand from the online Radio Player, the BBC was faced with rapidly rising distribution costs. 

With a finite budget, the choice was to reduce bandwidth of the live stream or cap the number of simultaneous users. By far the least disruptive option to most users was to reduce bandwidth - in this case by reducing the maximum bit rate - of the live stream. This results in a slight reduction in sound quality, noticeable to users with fast connections. 

Notwithstanding this reduction, BBC radio services are still streamed at a higher bit rate than the majority of non-BBC online radio services in the UK. 

We are looking at a number of other ways of reducing the bandwidth requirement of live streams which would enable us to increase the quality of the streams once more. 
Why is nothing appearing in the status window?
In order to get information in the status window (located beneath the 'listen live' link) you need to have JavaScript enabled.

To enable JavaScript in Internet Explorer go to the 'Tools' menu and select 'Internet Options' then click on the 'Security' tab. Make sure the 'Internet' icon (with a globe) is highlighted in blue. Click the 'Custom Level' button down near the bottom. Scroll down to the section entitled 'Scripting' and ensure that under 'Active Scripting' the button labelled 'Enable' is checked. Click OK. You will need to restart your browser for the change to take effect. 

To enable JavaScript in Netscape go to the 'Edit' menu and select 'Preferences'. Highlight the 'Advanced' label and ensure that the 'Enable JavaScript' checkbox is ticked. Click OK.

Mac users will not see any text in the status window and will need to access the controls at the bottom of the page 
Why does the player sometimes disappear and how can find it again?
The Radio Player operates within its own pop-up browser window, enabling you to navigate elsewhere on the Internet whilst continuing to listen to BBC Radio. This means that from time to time the player may become hidden behind another window. If the player is not visible and you wish to restore it, you must maximise it by clicking on the 'BBC Radio Player' tab in the taskbar (this runs along the bottom of the screen) 
Do I have to pay to download RealPlayer? No, you can download the FREE version by following the links at the top of this page. If you have accidentally downloaded a subscription version of RealPlayer please contact Real directly at http://service.real.com/realplayer/ 
Why are the Play and Pause buttons on the BBC Radio Player not formed in the Opera browser? The controls have been hidden from Opera users because they don't work in Opera. Opera users can listen in only a basic way as a result. 
When I select the listen live link in the Radio Player I repeatedly get "web site not found or unavailable"
Try emptying the clip cache in Real Player or Real One:
Run the stand alone Real Player or Real One application.
View > Preferences > Performance > Clip Cache > Settings > click on 'empty clip cache'
(The click path described here may vary between different versions of the Real application)
If this doesn't fix the problem, check your firewall settings. 
Can I download a programme to listen to later?
As part of a trial, the BBC is currently offering a limited number of radio programmes as downloads and podcasts. The trial runs from May 2005 until December 2005. You can find out all about it, and see a list of programmes, here: http://www.bbc.co.uk/radio/downloadtrial/. 
Can you give me the direct URL of your audio streams?
Sorry, but we can only offer support for streaming via the Radio Player and cannot give out direct URLs. 
Can I listen to BBC Radio programmes using iTunes?
There are no plans at present to use iTunes to distribute our programmes - the Radio Player is currently the only way to listen again to BBC Radio shows. 
Can I listen to BBC Radio programmes using my mobile phone?
There is no service to stream or download BBC radio programmes onto mobile devices at the moment. However we are always researching new ways of making the BBC's content available. 

Visit here for more information on the BBC's current mobile services: http://www.bbc.co.uk/mobile/web/index.shtml 
Why can't I rewind a show whilst listening?
Due to copyright restrictions we are unable to provide rewind functionality on shows that contain music. 
Why can I only fast forward in 5 or 15 minute chunks when listening to music shows?
Unfortunately our rights agreements with the record companies mean that we cannot break music programmes up into smaller chunks, or offer a rewind facility. 
Why are on demand programmes sometimes cut short?
The recording of on demand programmes is done automatically on the basis of their scheduled broadcast times. If a programme overruns the last few minutes will sometimes not be captured. We are working on ways to resolve this issue. 

Why are only some BBC Radio shows available on demand?
The BBC Radio Player launched in June 2002 with a selection of specialist shows. We have since expanded the service to offer a wider selection of programmes. The further expansion of this service is dependent on infrastructural changes which we are currently investigating. Please note: Due to rights restrictions Radio 4's Desert Island Discs cannot be made available on demand 
Why are the shows only available for seven days?
There are various copyright issues relating to this service which mean we are only permitted to offer these shows for a period of 7 days. Some speech-based programmes may be available for longer. 
Why can't I listen to some Five Live sporting events online?
We only have the rights to broadcast certain sporting events in the UK - not worldwide. These include Premiership football matches and Formula One Grand Prix. So you can listen on 909 & 693AM and on digital radio and digital TV - but not over the internet because this can be accessed across the globe 
Why can't I listen to football commentary on my local radio station?
For a number of high profile sporting events, such as the Premiership, the BBC only holds the rights to broadcast live commentary locally to the area covered by our radio transmitters. Our internet service is available across the UK and around the world and therefore we need to blank all output for which we do not hold international rights. We apologise for any inconvenience, but you can still listen to live commentary from your local station on your radio. 
Why does the end of another programme sometimes appear at the beginning of a clip?
To ensure that the whole of a show is available to you, the recording may start early. This is unlikely to be more than a minute or two, so we advise you to listen through this rather than skip 5 mins 
Why do I get a voice saying the programme I want is unavailable?
Online rights for music programmes last seven days. If a programme is not broadcast one week and the online rights expire, we have to make the online version of the programme unavailable. Rarely, technical difficulties may prevent a programme from appearing. 
How soon after the broadcast does a programme become available to listen to again in the Radio Player?
About an hour or two, depending on where you are listening from and the length of the programme. 
What rights do teachers have to use programmes in the Radio Player in the classroom?
Teachers are free to "play" programmes currently presented in the Radio Player to classes as the playing/performing of copyright works, including sound recordings, in the course of activities of educational establishments does not infringe copyright. However, the BBC's agreements with rights holders prevent the BBC from authorising copies being made of Radio Player streams. 
To use the BBC Radio Player you will need to have a program called RealPlayer installed on your computer. Download it for FREE by clicking below: 

Go to Download Realplayer page
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Step-by-step instructions for installing RealOne player

Linux and Unix users should read our Unix/Linux advice page before proceeding. 

Installation Guide for Windows 98 / XP / 2000 / ME

Installation Guide for Mac OS X

Installation Guide for Mac OS 9

Step-by-step instructions for installing RealPlayer 8
1. Click on the below link

Download RealPlayer 8

2. Fill out the form, entering a valid email address and choosing the appropriate operating system and connection speed. Then click the "Download FREE RealPlayer 8 Basic" button

3. This takes you to a page where you can select your download option. The "Minimum" option will take the least time. Select this and click the "Download FREE RealPlayer 8 Basic" button to proceed

4. On the following page, you should click on the link of the location nearest to you. Picking the nearest place should make your download quicker

5. When you've clicked on the link it will bring up a file download box - this will begin saving the program to your computer. Click "Save" 

[image: image2.jpg]ou e doprioadog the e
ipBseh e o 1931532084

Woudyoulko o cpen thele o« save 1 our computr?

O P

7 s sk e cpenigts s o i





6. Another box will pop up, which lets you choose where to save the program. From the "Save In" menu select "Desktop" (Saving it on the desktop means you'll be able to find it easily) 
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7. Click on "Save" and the RealPlayer will start to download - it may take some time depending on the speed of your Internet connection

8. Once downloading has completed, double click on the file icon (a RealPlayer symbol) on your desktop. RealPlayer will begin to set up on your computer 
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9. From here, follow the instructions that RealPlayer gives you - all you really need to do is skip through the screens by clicking on "Next" - though if you're feeling adventurous, you could change some of the settings - but make sure you know what you're doing!

10. Once it's finished installing, RealPlayer will start - from here you can close it down, and then click on the links to listen to audio and watch video - whenever RealPlayer is needed, it will automatically start! 

Netscape users Netscape users with Real Player 8 will need to download an additional RealPlayer Plug-in 
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Mozilla-based browser users
PC
If you installed your browser after installing Real Player One, the plugins may not be there. Check your browser's plugin folder for nppl3260.dll and the components folder for nppl3260.xpt. If they are not there, then you will need to copy:

· C:\Program Files\Real\RealOne Player\Netscape6\nppl3260.xpt into C:\Program Files\mozilla.org\Mozilla\components\nppl3260.xpt (or wherever your browser is installed)

· C:\Program Files\Real\RealOne Player\Netscape6\nppl3260.dll into C:\Program Files\mozilla.org\Mozilla\Plugins\nppl3260.dll (or wherever your browser is installed


If you are using Windows, you might not have the Java plugin. The mozdev plugin site can help you find and install it. 

Mac
Some users have experienced issues around the embedded Real Player within Mozilla, Firefox or Camino on a Mac. To resolve this, we recommend that you download the latest version of Real Player from this page. Otherwise, we suggest that you try another browser such as Safari or Internet Explorer. 

Opera users
Some Opera users have reported problems when upgrading to Real Player 10. These users have found that backing up the file nppl3260.dll (127K) from the Opera Plugins folder and copying that back into the plugins folder after installation, over the nppl3260.dll (139K) file that is installed with Real Player 10, has solved their problem. Opera users will need to download the same RealPlayer Plug-in then follow the below process:

1. Open Opera
2. Go to 'Preferences' (Alt+P)
3. Go to 'Multimedia'
4. Click on 'Find Plugins'
5. When it asks you to associate the RealPlayer plug-in, choose 'yes'

Please note that Opera users will experience a 10-15 second wait while the audio is loaded 

Useful links:
Radio 1 Audio/video
Radio 4 Listen Again
Radio 1's audio guide
Radio 2's audio guide
Five Live's audio guide
WebWise guide
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So what is it?   Want to listen to internet audio programs but can't when they are scheduled? This program lets you create your own custom online audio anytime, anywhere. Really. 

	Download Juice now, it's free!




Download
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Download
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Juice Receiver is Free Software licensed under the GPL. 
	[image: image13.png]





If you want to listen to podcasts, this program is for you. Juice is the premier podcast receiver, allowing users to capture and listen to podcasts anytime, anywhere. 

How to Install:

Screenshots Juice (latest version)   Windows
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Subscriptions tab 
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Downloads tab 

[image: image16.png]© Juice - Podcast receiver v2.0 LEE

Fle Edt Vew Toos Help

Downioads | Subscrptons [ Fodeas drecioy ] Cieanup|

[V - bt

Directory
&) iPodder org: Podcasting Cenlral
=& Adam Cury's Pod Squad
The Daun and Drew Shaw
The Gillnor Gang (w/Steve Gillnor)
Fieel Reviews - Fis Woth Watching
The Rack and Fol Geek Shon
Yeast Rado
The Skinny O Sports
The Daily Soce Code
&) iPodder Team Directory
& Poddeix Top Picks
& Poddeix Most Popular
& Podoast Alley Top 50
1) Podoast Alley 10 Newest
) GigaDial 25 Latest
) Sports Podcast Network

Clck on a feed nthe lies o1 ype/paste inthe space above then cick add.

1 enclosure fetched





Directory tab 
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Cleanup tab 
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Cleanup tab 
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Why should I squeeze Juice?
  Juice is free

  Juice supports more than 15 languages

  Juice supports multiple media players

  Juice is free software licensed under the GPL (open source)

  Juice's primary purpose is to manage podcasts

  Juice has a built-in directory with thousands of listed podcast feeds

  Juice has auto cleanup, authentication, centralized feed management and much more

  Juice is accessible for blind and visually impaired users (windows version only)

  Juice is fresh!

Useful resources
We recommend these resources as good places for podcast listeners: 
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	PodNova is a distributed podcast directory. It’s maintained by dozens of volunteers from around the world. It features a way to search and subscribe with one click, secure subscription management and an easy way to synchronize your podcatch clients via OPML and RSS.
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	GigaDial is a new approach to radio programming. You can use it to create and subscribe to podcast-powered stations composed of individual episodes from your favorite podcasters.
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	The PodSafe music network is designed to give podcasters access to music, other content and tools to create royalty-free podcasts. Musicians can use the network to promote and market their music, while listeners can access music in single-play or podcast formats. 
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	PodcastPickle.com seeks to bring users the freshest content on the Web through the vast directory of podcasts. It is a community for podcasters and podcast listeners. 
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	R-mail lets you watch an RSS subscription via email.
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 HYPERLINK "http://www.podcast.net/addpodcast" 


	
	
	
	
	


